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WinADCP User's Guide 
 

1 Introduction 
This guide is an overview on using the WinADCP software provided with your 
system.   

 
NOTE.  This guide covers version 1.14 or earlier. 

 

 

CAUTION.  WinADCP is not compatible for viewing and/or exporting 
WinRiver data, or data collected in Ship or Instrument coordinates.  Using 
WinADCP to display and/or export WinRiver data results in an incorrect 
naming structure.  Data is called Earth coordinates when it is actually Ship 
coordinates.   

 

1.1 How to Contact Teledyne RD Instruments 
If you have technical issues or questions involving a specific application or dep-
loyment with your instrument, contact our Field Service group:  
Teledyne RD Instruments  Teledyne RD Instruments Europe 

14020 Stowe Drive 
Poway, California 92064 

 2A Les Nertieres 
5 Avenue Hector Pintus 
06610 La Gaude, France 

Phone +1 (858) 842-2600  Phone +33(0) 492-110-930 

FAX +1 (858) 842-2822  FAX +33(0) 492-110-931 

Sales – rdisales@teledyne.com  Sales – rdie@teledyne.com 

Field Service – rdifs@teledyne.com  Field Service – rdiefs@teledyne.com 

Client Services Administration – rdicsadmin@teledyne.com  
Web: http://www.rdinstruments.com 

24 Hour Emergency Support +1 (858) 842-2700 
 

mailto:rdisales@teledyne.com�
mailto:rdie@teledyne.com�
mailto:rdifs@teledyne.com�
mailto:rdiefs@teledyne.com�
mailto:rdicsadmin@teledyne.com�
http://www.rdinstruments.com/�
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1.2 System Requirements 
WinADCP requires the following: 

• Windows Vista®, Windows XP®, or Windows 2000®   

• Pentium III 600 MHz class PC (higher recommended) 

• 64 megabytes of RAM (128 MB RAM recommended) 

• 50 MB Free Disk Space plus space for data files (A large, fast hard 
disk is recommended) 

• One Serial Port (two or more High Speed UART Serial Port recom-
mended) 

• Minimum display resolution of 1024 x 768, 256 color (higher rec-
ommended) 

• CD-ROM Drive 

• Mouse or other pointing device 

1.3 Software Installation 
To install the software, do the following. 

a. Insert the compact disc into your CD-ROM drive and then follow the brows-
er instructions on your screen.  If the browser does not appear, complete 
Steps “b” through “d.” 

b. Click the Start button, and then click Run. 

c. Type <drive>:launch.  For example, if your CD-ROM drive is drive D, type 
d:launch. 

d. Follow the browser instructions on your screen. 

Once, installed, you will have a shortcut added to your Windows® Start menu.  
The Winadcp shortcut will start WinADCP.   

 
NOTE.  The default directory for WinADCP installation is C:\program 
files\RD Instruments\Winadcp.   
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2 Using WinADCP 
WinADCP is a software package for use with RDI Acoustic Doppler Current 
Profilers.  This software package supports both the Narrowband and the Broad-
band/Workhorse Binary Output Data Formats.  

In general, WinADCP gives the user a visual sense of the entire set of data.  It 
also allows the user to zoom in on a portion of the data for closer analysis. 

2.1 Opening Data Files 
You can open BroadBand, NarrowBand, or WorkHorse raw binary data files.  
Binary data files that have segmented consecutive file names (i.e. 
DEMO001r.000, DEMO001r.001, DEMO001r.002) will be read in as one file if 
MultiFile is enabled on the File menu.   

a. On the File menu, check that MultiFile is checked.  Click Open. 

b. Select the data file to be opened.   

c. Click Open. 

2.2 Whole Set 
WinADCP has two main graphic display forms.  The form located in the upper 
right portion of the screen is called the Whole Set.  The form located across the 
bottom half of the display is called the Sub Set.  Each of these forms displays a 
portion of the entire data set as a color contour.  In addition to the color contour, 
Sub Set displays the user selected Profile, Series, and Ancillary data. 

The Whole Set form is displayed in the upper right-hand portion of WinADCP.  
When a file containing a Binary Output Data Format is opened, the entire set of 
the selected data type is displayed as a color contour located within the Whole 
Set form.  

 
Figure 1. Whole Set 
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Figure 2. Sub Set 

2.3 Selected Set 
By holding down the Spacebar and then pressing the Left mouse button, the 
user can drag the mouse to select a portion of the entire data set.  When the 
mouse button is released, the selected portion of the Whole Set is marked by a 
blinking box outline.  The blinking box outlines a set of data called the Selected 
Set.  A second blinking box is also created when the mouse is released.  This 
second box is striped or solid depending on your graphics card.  The solid blink-
ing box marks a region of data called the Sub Set.  The width of the Sub Set 
box may not be as wide as the Selected Set box.  The width of the Sub Set is 
dependent upon the Options, Ensembles setting selected from the main menu.  

Figure 1 shows an example of the Whole Set contour display.  The Sub Set con-
tour display is identical except it does not show the Selected and Sub Set en-
semble numbers (located in the upper right corner of the chart). 

 
Figure 3. Selected Set 
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2.4 Profile Chart 
The Profile chart, located on the left side of the Sub Set form, displays a user 
selected ensemble in several two dimensional (2D) charts.  Each of these “sub 
charts” contains a different data type taken from the ensemble.  The user can 
select the profile ensemble by double clicking the left mouse button just above 
or just below the Sub Set color contour. 

 

NOTE.  Use the left and right keyboard arrows to scroll through the 
ensembles.  Use the Animate menu to automatically scroll through the 
data file.  To quickly select an ensemble, double-click a point just above or 
below the Sub Set color contour plot.   

 

 
Figure 4. Profile Chart 

2.5 Series Chart 
The Series and Ancillary chart, located in the lower left-hand portion of Sub 
Set, displays user selected bins of user selected data types.  In addition, the user 
may select any of the ancillary data types for display in this chart.  

The candle chart shows the statistical information about the series chart.  Use 
the Options, Chart Options menu to select the Averaging Interval.  The can-
dle chart will be centered on the averaging interval. 

• The red line is the mean 

• The middle rectangle shape is the Standard Deviation 

• The long line shows the minimum and maximum values 

 
NOTE.  Double-click the candle chart to display the Series Trend and 
Residuals chart. 

 

 

NOTE.  Use the up and down keyboard arrows to scroll through the bins.  
Use the Animate menu to automatically scroll through the data file.  To 
quickly select multiple bins, double-click a point just to the left or right of 
the color contour plot on the Sub Set color contour plot.  Double clicking 
the same point will unselect the bin. 
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Figure 5. Series and Ancillary Chart 

 
Figure 6. Series Trend and Residuals Chart 

2.6 Track Vector Time Series 
The Track Vector Time Series window displays two current vectors: one along 
a selected track and the other orthogonal to it (90 degrees).  The user can select 
three different tracks: Navigation, Bottom, and Projected.  Navigation and 
Bottom use actual data contained within the ADCP ensemble.  The Projected 
angle is input by the user.  

An application where this display is useful is in cable laying.  Ocean currents 
across the path of a ship tend to pull a cable off to the side.  Information about 
current magnitude and direction relative to the ship track helps to guide the ship 
for better cable placement. 
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Figure 7. Track Vector Time Series 

The Track Vector Time Series window has its’ own menu. 

Exit – Exits the Track Vector Time Series window.  To display the window 
again, click Window, Track Vector. 

Animate – Choose Go to animate the chart.  Stop will stop the animation and 
Rewind will rewind the chart to the beginning of the file.   

Projection – Choose between Bottom Track, Navigation Track, or Manual.  If 
you select Manual, you can select your own projection angle.   

Reference – Clicking Reference will display the Chart Options menu, 
Processing tab.  Choose a reference from the list.   

Display – Clicking Display will let you choose the Units, and Font for the dis-
play.  Selecting Time Origin on Left will toggle the time origin being displayed 
on the right, to the left side of the display. 

Clicking anywhere on the Track Vector Time Series display will display the 
Chart Options menu, Series tab.  Choose the bins to display by selecting the 
bin box on the list.   

 

NOTE.  The Animation and Reference menus are disabled on the Track 
Vector window when the Monitor mode is enabled.  All other menus are 
available. 

Negative range numbers are shown when the system is downward facing 
(bins are below transducer).  If the system is upward facing the range 
numbers are positive. 
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2.7 Saving Files 
The Selected and Sub Set plots may be saved to new data files as needed. 

2.7.1 Save a Sub Set File 
On the Whole Set color contour plot, use the Zoom feature (see Selected Set) to 
select the portion of the Whole Set to be displayed in the Sub Set color contour 
plot.  You can use the zoom feature on the Sub Set color contour plot to further 
zoom in on the data. 

a. On the File menu, click Save Sub Set. 
b. Give the file a unique name.  WinADCP does not add an extension type to 

the file.  To organize data files, you may want to add the *.000 file exten-
sion. 

c. Click Save. 

 
CAUTION.  If the file name already exists as a closed data file, then the file 
will be written over.  You will be prompted if it is OK to overwrite the file. 

 

 

NOTE.  If the file name you select is the same as the currently open file 
then the Sub Set of data is not written to the file. 

The Sub Set has a limit of 8,192 ensembles. 

If the Binary Data File that was opened had segmented consecutive file 
names (i.e. DEMO001r.000, DEMO001r.001, DEMO001r.002) when you 
save the Sub Set, it will be saved as one file.  Make sure you use a unique 
name to avoid overwriting a data file. 

The format of the Sub Set file is the same as the raw ADCP Binary Data 
File format.  Sub Set files may be opened with other RDI Software. 

2.7.2 Save the Selected Set 
On the Whole Set color contour plot, use the Zoom feature to select the Se-
lected Set.   
a. On the File menu, click Save Selected Set. 
b. Give the file a unique name.  WinADCP does not add an extension type to 

the file.  To organize data files, you may want to add the *.000 file exten-
sion. 

c. Click Save. 

 
CAUTION.  If the file name already exists as a closed data file, then the file 
will be written over.  You will be prompted if it is OK to overwrite the file. 
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NOTE.  If the file name you select is the same as the currently open file 
then the Sub Set of data is not written to the file. 

The Selected Set does not have a limit on the number of ensembles. 

If the Binary Data File that was opened had segmented consecutive file 
names (i.e. DEMO001r.000, DEMO001r.001, DEMO001r.002) when you 
save the Selected Set, it will be saved as one file.  Make sure you use a 
unique name to avoid overwriting a data file. 

The format of the Selected Set file is the same as the raw ADCP Binary 
Data File format.  Selected Set files may be opened with other RDI 
Software. 

 

2.8 Printing Charts 
Charts may be copied to the Windows® clipboard so that they may be pasted or 
printed in other programs. 

a. On the Edit menu, click Copy. 

b. Select either the Whole Set or the Sub Set. 
c. The chart will be placed on the Windows clipboard. 

d. Open the graphic program (or Word) and select Edit, Paste. 

e. Use the graphic program (or Word) to print the chart. 

 

NOTE.  If you use the Edit, MSPAINT menu the Whole Set or Sub Set will 
be placed as a Bit Map image on the Windows clipboard and will open the 
Microsoft Paint program.  In Paint, select Edit, Paste to display the Bit 
Map.   

The shortcut to the Microsoft Paint program expects the program to be in 
the default directory C:\Windows. 

 

2.9 Flip 
Selecting Flip from the Edit menu causes the file to be re-read with the orienta-
tion bit inverted. In other words, an upward facing data set appears as a down-
ward set when Flip is clicked. 
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2.10 Data Viewer 
When the Mouse is positioned over a point within the Sub Set color contour 
charts, data associated with the bin and ensemble are shown on the Viewer 
form.  If the Viewer is not visible, select the Window menu and click on View-
er.  A sample of the Viewer is shown below. 

 
Figure 8. Data Viewer 

Most items are self-explanatory, however the ARRAY data in the center requires 
explanation.  There are three rows of data: 

a. The top row contains Velocity data (V).  The first value is -462; this is the 
Eastward velocity component in millimeters per second.  The 95 is the 
Northward followed by the Vertical, error, Magnitude, and Direction of the 
velocity.  

b. The middle row contains Echo Intensity data in counts.  The 150 is Beam 1’s 
Echo Intensity followed by Beams 2, 3, and 4.  The last value (149) is the 
average of the four Echo Intensity values. 

c. The last row contains Correlation data if the ADCP is a Broadband or 
WorkHorse otherwise Spectral width for the Narrowband ADCP. If the data 
are not available then zeros are displayed. 



 WinADCP User's Guide 

P/N 957-6158-00 (January 2009) page 11 

 
Figure 9. Data Viewer with MicroCAT Data 

 
NOTE.  Lat/Lon and MicroCAT data will not be visible unless the data was 
collected. 
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2.11 File Details 
On the Utilities menu, click File Details.  Select the data file to be examined.  
The file utility window will show you everything there is to know about the file 
contents. 

 
Figure 10. File Details 
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3 Chart Options 
The Options menu controls how the displays are shown.  Selecting Chart Op-
tions under the Options Menu brings up the Chart Options dialog box.  There 
are five tabs on the dialog box:  

• Contour Tab  

• Profile Tab  

• Series Tab  

• Ancillary Tab  

• Processing Tab  
Five buttons are positioned along the bottom of the Chart Options dialog box. 

Load - reads in, from a selected file, a previously saved set of option pages. 

Save - writes out, to a named file, the contents of the option pages. 

OK - updates the screen to the new setting(s) and close the options dialog. 

Cancel - close the options dialog. 

Apply - update the screen to the new setting(s) but does not close the options 
dialog. 

 

NOTE.  Max Ensembles, under the Options menu, is used to set the 
maximum number of ensembles shown in both the Sub Set Color 
Contour and Series charts. 

 

3.1 Reset to Default Settings 
When WinADCP is closed, the current chart settings are saved in two files 
located in the WinADCP install directory for Windows XP® computers.  For 
Vista® computers, the path is C:\Users\User Login Name\App 
Data\Local\Virtual Store\Program Files\RD Instruments\WinADCP.  The next 
time WinADCP is opened it will access these two files and open with the 
previously used settings.  Sometimes these user settings make it difficult to read 
or make sense of different data sets.   

To reset WinADCP back to the default settings, with WinADCP closed, delete 
WADPFile.txt and WADPOps.Txt.  Once the files have been deleted, open 
WinADCP.  WinADCP will create a new WADPFile.txt and WADPOps.Txt with 
the default chart option settings for WinADCP. 
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3.2 Contour Tab 
The Contour tab has five control groups for controlling the Whole Set, Sub Set 
and color contour charts.  

 
Figure 11. Contour Tab 

Scale - Five choices for selecting the maximum and minimum values of the col-
or scale. 

• Manual - user entry of values. 

• Peak - Automatic setting to the max/min values contained in the data 
set. 

• 1 std - Automatic setting to data mean plus and minus ONE standard 
deviation. 

• 2 std - same as above but TWO standard deviations. 

• 3 std - same as above but THREE standard deviations. 

Appearance - Three check boxes. 

• Locators - turn on/off the blinking boxes of the Whole Set color con-
tour.  

• Grid - turn on/off the grid that overlays both color contour charts. 
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• BT Depth – When checked and Bottom Track depth data is available, 
a bottom contour line is drawn on top of the color contour plot.  If 
beam 1 through 4 RSSI or correlation is selected for display, the 
beams depth is shown.  Any other selection will show the contour 
line as the average of the four beams. 

Data Type - Used to select one of the data types for display. 

Selected Set - Used to select the first and last ensembles of the Selected Set. 

Sub Set - Used to select the first and last ensembles of the Sub Set. 

3.3 Profile Tab 
The Profile tab has four control groups for controlling the Profile chart. 

 
Figure 12. Profile Tab 

Scale – The Scale setting allows manual selection of the maximum and mini-
mum values for each data type. 

Appearance - Three check boxes. 

• Lines - Turn on/off the connection of lines between data points. 

• Symbols - Turn on/off a symbol at each data point location. 

• Grid - Turn on/off the grids that overlay the profile charts. 
Ensemble - Used to select the current ensemble. 
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Data Type - Used to select several of the data types for display. 

3.4 Series Tab 
The Series tab has five control groups for controlling the Series chart. 

 
Figure 13. Series Tab 

Scale - The Scale setting allows manual selection of the maximum and mini-
mum values for each data type. 

Appearance - Four check boxes. 

• Combo - When selected each bin of a data type is plotted on the same 
chart. 

• Lines - Turn on/off the connection of lines between data points. 

• Symbols - Turn on/off a symbol at each data point location. 

• Grid - Turn on/off the grids that overlay the series charts. 
Data Type - Selects several of the data type for display. 

Statistics - Selects the time interval over which statistics are calculated.   

• All - The total time of the Sub Set data. 

• User - Used when several statistic sets over the Sub Set interval are 
desired. 
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Bins - Selects which bin to display. 

3.5 Ancillary Tab 
The Ancillary tab has three control groups for controlling the Ancillary chart. 

 
Figure 14. Ancillary Tab 

Scale – The Scale setting allows manual selection of the maximum and mini-
mum values for each data type. 

Appearance - Three check boxes. 

• Lines - Turn on/off the connection of lines between data points. 

• Symbols - Turn on/off a symbol at each data point location. 

• Grid - Turn on/off the grids that overlay the ancillary charts. 
Data Type - Selects several of the data type for display.  

 
NOTE.  Water density is used to convert pressure to depth, if the pressure 
data is available. 
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3.6 Processing Tab 
The Processing tab allows the selection of a velocity reference, velocity scale, 
and how the end of the water profile is determined  

Velocity Reference:  

• None – No velocity reference used. 

• Bottom Track – Use Bottom Track as the reference 

• Navigation (VmDas) - The Navigation (VmDas) is VmDas format 
only, don’t use this for WinRiver.   

• GPS (GGA) or GPS (VTG) - GPS (GGA) and GPS (VTG) are in 
WinRiver format. 

• Water Mass (BK <>1) - Use Water Mass as the reference 
Velocity Scale:  These values should not be changed.  Used for expert testing 
only. 

End of Profile:  Items may be multi-selected. 

• BT Depth – Cut off at the Bottom Track depth. 

• RSSI Bump Detection – Cut off where the RSSI bump is detected. 

• Cos(BeamAngle) – Cut off at the Cos(BeamAngle) 

• Cut 1 Bin – Cut off one extra bin. 

• Cut 2 Bins – Cut off two extra bins. 

 
Figure 15. Processing Tab 
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4 Exporting Data 
Clicking the main menu item Export brings up the WinADCP Export Options 
dialog box.  There are three styles of export: Contour, Profile, and Se-
ries/Ancillary.   

The MAT file output has a MatLab compatible binary format.  From MatLab 
type load filename.mat then type who.  The Column = Bin and Row = Ensemble.  A 
list of variables for each output format is shown. 

4.1 Contour 
Exporting contour data allows the selection of one data type (Velocity, Magni-
tude, Amplitude, Correlation, and Percent Good), the first/last ensembles, the 
first/last bins, and the file format. 

 
Figure 16. Export Data – Contour 

 
NOTE.  To quickly select bins, use the All or None buttons. 

 



WinADCP User's Guide 

page 20 RD Instruments 

The Contour export variables are: (Con refers to Contour) 
ConBins             RDIBinSize          RDIPingsPerEns       
ConEnsembles        RDIEnsDate          RDISecPerPing        
ConTitle            RDIEnsInterval      RDISystem            
ConVel              RDIEnsTime           
RDIBin1Mid          RDIFileName 
 

For the Profile export the variables are: (Pro refers to Profile) 
ProCor1cnts         ProEAmpBmAvgcnts    RDIEnsTime           
ProCor2cnts         ProEmmpersec        RDIFileName          
ProCor3cnts         ProErmmpersec       RDIPingsPerEns       
ProCor4cnts         ProMagmmsec         RDIProfileBins       
ProCorAvgcnts       ProNmmpersec        RDIProfileEns        
ProDir10thDeg       ProVmmpersec        RDISecPerPing        
ProEAmpBm1cnts      RDIBin1Mid          RDISystem            
ProEAmpBm2cnts      RDIBinSize           
ProEAmpBm3cnts      RDIEnsDate           
ProEAmpBm4cnts      RDIEnsInterval 
 

An example of the "TXT" format is shown below between the dashed lines. 

The row of numbers 1, 6, 11, 16 are the selected bin numbers.  

The columns of numbers 1390 through 1400 are ensemble numbers.  

The data set, which has 3598 in the upper left-hand corner, contains velocity 
magnitude data in mm/s. 
---------------------------------------------------------------------------- 
"Contour Data = Velocity Magnitude mm/s" 
"C:\DATA\Sampdata.000" 
"Broadband 614.4 kHz" 
"Pings/Ens =" 5 
"Time/Ping = 00:00.00" 
"First Ensemble Date = 95/03/21" 
"First Ensemble Time = 03:44:23.78" 
"Ensemble Interval (s) = " 1.71 
"1st Bin Range (m) = " 0.33 
"Bin Size (m) =" 0.10 
 
      1    6    11   16 
 
1390  3598 2619 3099 998 
1391  2867 2464 2919 491 
1392  2350 3040 2357 805 
1393  3156 2438 2682 2138 
1394  3025 2520 2096 2305 
1395  2303 2918 2121 271 
1396  1990 3129 3232 421 
1397  3006 2079 947  644 
1398  2341 2027 1804 657 
1399  2390 1334 1854 616 
1400  2426 2175 2135 514 
---------------------------------------------------------------------------- 
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4.2 Profile 
Exporting Profile data allows the selection of many data types, one ensemble, 
the first/last bins, and the file format. 

 
Figure 17. Export Data – Profile 

 
NOTE.  To quickly select bins, use the All or None buttons. 

 

An example of the “TXT” format is shown below between the dashed lines. 

The row of numbers 1, 5, 9, 13, 17 are the selected bin numbers.  

The left-hand column contains data type titles (16 possible): 

• “EAA” is Echo Amplitude Average (average of the four beams).  

• “CA” is Correlation Average (average of four beams).  

• “Mag mm/s” is the velocity Magnitude in millimeters per second.  

• “Dir deg” is the velocity Direction in degrees. 
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---------------------------------------------------------------------------- 
"Profile Data Ensemble Number = " 1341 
"C:\DATA\Sampdata.000" 
"Broadband 614.4 kHz" 
"Pings/Ens =" 5 
"Time/Ping = 00:00.00" 
"First Ensemble Date = 95/03/21" 
"First Ensemble Time = 03:43:02.46" 
"Ensemble Interval (s) = " 1.71 
"1st Bin Range (m) = " 0.33 
"Bin Size (m) =" 0.10 
 

    1    5    9    13   17 
 
"EAA cnts"   173  169  152  148  122 
"CA cnts"   138  156  100  132  122 
"Mag mm/s"   1499 612  799  608  1344 
"Dir deg "   91.3 54.9 163.3 92.7 80.0 
---------------------------------------------------------------------------- 
 

4.3 Series/Ancillary 
Exporting Series/Ancillary data allows the selection of many data types, the 
first/last ensembles, the first/last bins (of the series data), and the file format. 

 
Figure 18. Export Data – Series/Ancillary 
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NOTE.  To quickly select bins, use the All or None buttons. 

 

 

NOTE.  If you are exporting navigation data form a data file collected with 
WinRiver, make sure to check the WinRiver box.  This lets WinADCP 
know where to look for the navigation data. 

 

An example of the “TXT” format is shown below between the dashed lines. 

The row of numbers 1, 7, 13, 19 are the selected bin numbers.  

Ancillary data does not have a bin number above it. 

The columns of numbers 1390 through 1400 are ensemble numbers.  
---------------------------------------------------------------------------- 
"Series Data" 
"C:\DATA\STEIN\BIGGE\TRANDATA\Bigg020r.000" 
"Broadband 614.4 kHz" 
"Pings/Ens =" 5 
"Time/Ping = 00:00.00" 
"First Ensemble Date = 95/03/21" 
"First Ensemble Time = 03:44:23.78" 
"Ensemble Interval (s) = " 1.71 
"1st Bin Range (m) = " 0.33 
"Bin Size (m) =" 0.10 
 
 
   "Hea" "Mag" "Mag" "Mag" "Mag" "Dir" "Dir" "Dir" "Dir" 
   "deg" "mm/s" "mm/s" "mm/s" "mm/s" "deg" "deg" "deg" "deg" 
    1 7 13 19 1 7 13 19 
 
1390  178.62 3598 3182 1289 1627 87.8 102.9 71.5 68.7 
1391  177.85 2867 2958 1474 1736 80.9 87.4 61.9 57.6 
1392  179.65 2350 2435 2154 1986 82.6 91.3 80.9 84.8 
1393  179.30 3156 2533 1831 2156 91.1 100.3 82.5 94.0 
1394  179.75 3025 2514 1463 1107 91.7 62.7 99.7 92.0 
1395  178.53 2303 2475 1652 1407 100.6 83.4 92.0 73.8 
1396  179.53 1990 2884 1989 2621 85.9 93.0 100.5 90.5 
1397  177.95 3006 2652 1379 1396 92.3 84.7 78.5 79.4 
1398  177.62 2341 2257 1127 1468 87.1 85.0 83.1 66.0 
1399  177.52 2390 2069 1184 630  88.2 93.8 75.4 115.2 
1400  174.92 2426 2625 2901 1655 87.3 85.0 75.4 63.3 
 
---------------------------------------------------------------------------- 
 

MicroCAT export is available as TXT format only. 
"Series Data" 
"C:\My Documents\TEST2" 
"Broadband 614.4 kHz" 
"Pings/Ens =" 6 
"Time/Ping = 00:01.00" 
"First Ensemble Date = 01/10/10" 
"First Ensemble Time = 11:13:50.72" 
"Ensemble Interval (s) = " 10.00 
"1st Bin Range (m) = " 3.11 
"Bin Size (m) =" 2.00 
 
 
Ens HH MM SS HH  "Pit" "Rol" "BIT" "MicroCAT" 
      "deg" "deg" "" 
         
 
1 11 13 50 72  -0.13 -0.36 0 01, 00000,  5.8361, 3.44779,  366.974,  35.1075, 01 Jan 1980, 04:43:00 
2 11 14 00 72  -0.13 -0.35 0 01, 00000,  5.8365, 3.44779,  366.972,  35.1070, 01 Jan 1980, 04:43:10 
3 11 14 10 72  -0.14 -0.36 0 01, 00000,  5.8364, 3.44779,  366.991,  35.1072, 01 Jan 1980, 04:43:20 
4 11 14 20 72  -0.14 -0.36 0 01, 00000,  5.8363, 3.44779,  366.995,  35.1072, 01 Jan 1980, 04:43:30 
5 11 14 30 72  -0.14 -0.35 0 01, 00000,  5.8363, 3.44779,  366.997,  35.1072, 01 Jan 1980, 04:43:40 
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6 11 14 40 72  -0.13 -0.36 0 01, 00000,  5.8363, 3.44778,  367.000,  35.1071, 01 Jan 1980, 04:43:50 
7 11 14 50 72  -0.13 -0.35 0 01, 00000,  5.8362, 3.44778,  366.993,  35.1073, 01 Jan 1980, 04:44:00 
8 11 15 00 72  -0.14 -0.36 0 01, 00000,  5.8363, 3.44779,  366.995,  35.1073, 01 Jan 1980, 04:44:10 
9 11 15 10 72  -0.13 -0.36 0 01, 00000,  5.8362, 3.44779,  367.006,  35.1073, 01 Jan 1980, 04:44:20 
10 11 15 20 72  -0.13 -0.35 0 01, 00000,  5.8362, 3.44778,  367.000,  35.1072, 01 Jan 1980, 04:44:30 
11 11 15 30 72  -0.13 -0.35 0 01, 00000,  5.8361, 3.44779,  366.998,  35.1075, 01 Jan 1980, 04:44:40 
12 11 15 40 72  -0.13 -0.35 0 01, 00000,  5.8360, 3.44778,  366.990,  35.1074, 01 Jan 1980, 04:44:50 
13 11 15 50 72  -0.13 -0.36 0 01, 00000,  5.8363, 3.44778,  366.984,  35.1071, 01 Jan 1980, 04:45:00 
14 11 16 00 72  -0.13 -0.36 0 01, 00000,  5.8363, 3.44779,  366.980,  35.1072, 01 Jan 1980, 04:45:10 
15 11 16 10 72  -0.13 -0.35 0 01, 00000,  5.8359, 3.44779,  366.984,  35.1077, 01 Jan 1980, 04:45:20 
16 11 16 20 72  -0.13 -0.36 0 01, 00000,  5.8363, 3.44778,  366.982,  35.1071, 01 Jan 1980, 04:45:30 
17 11 16 30 72  -0.13 -0.36 0 01, 00000,  5.8361, 3.44779,  366.993,  35.1075, 01 Jan 1980, 04:45:40 
18 11 16 40 72  -0.13 -0.36 0 01, 00000,  5.8363, 3.44778,  366.999,  35.1071, 01 Jan 1980, 04:45:50 
19 11 16 50 72  -0.13 -0.36 0 01, 00000,  5.8364, 3.44777,  366.989,  35.1069, 01 Jan 1980, 04:46:00 
20 11 17 00 72  -0.13 -0.36 0 01, 00000,  5.8362, 3.44778,  366.986,  35.1072, 01 Jan 1980, 04:46:10 
21 11 17 10 72  -0.13 -0.36 0 01, 00000,  5.8362, 3.44778,  366.984,  35.1072, 01 Jan 1980, 04:46:20 
22 11 17 20 72  -0.12 -0.36 0 01, 00000,  5.8361, 3.44778,  366.985,  35.1074, 01 Jan 1980, 04:46:30 
23 11 17 30 72  -0.13 -0.36 0 01, 00000,  5.8361, 3.44778,  366.981,  35.1074, 01 Jan 1980, 04:46:40 
24 11 17 40 72  -0.13 -0.35 0 01, 00000,  5.8360, 3.44778,  366.984,  35.1074, 01 Jan 1980, 04:46:50 
25 11 17 50 72  -0.12 -0.36 0 01, 00000,  5.8363, 3.44778,  366.977,  35.1072, 01 Jan 1980, 04:47:00 
26 11 18 00 72  -0.12 -0.36 0 01, 00000,  5.8363, 3.44778,  366.990,  35.1072, 01 Jan 1980, 04:47:10 
27 11 18 10 72  -0.12 -0.35 0 01, 00000,  5.8363, 3.44778,  366.980,  35.1072, 01 Jan 1980, 04:47:20 
28 11 18 20 72  -0.12 -0.36 0 01, 00000,  5.8363, 3.44777,  366.980,  35.1070, 01 Jan 1980, 04:47:30 
29 11 18 30 72  -0.12 -0.36 0 01, 00000,  5.8362, 3.44778,  366.996,  35.1072, 01 Jan 1980, 04:47:40 
30 11 18 40 72  -0.12 -0.34 0 01, 00000,  5.8362, 3.44778,  366.996,  35.1073, 01 Jan 1980, 04:47:50 
31 11 18 50 72  -0.11 -0.35 0 01, 00000,  5.8365, 3.44778,  366.997,  35.1070, 01 Jan 1980, 04:48:00 
32 11 19 00 72  -0.11 -0.35 0 01, 00000,  5.8365, 3.44778,  366.989,  35.1069, 01 Jan 1980, 04:48:10 
33 11 19 10 72  -0.11 -0.35 0 01, 00000,  5.8362, 3.44777,  366.983,  35.1072, 01 Jan 1980, 04:48:20 
34 11 19 20 72  -0.09 -0.36 0 01, 00000,  5.8361, 3.44778,  367.017,  35.1074, 01 Jan 1980, 04:48:30 
35 11 19 30 72  -0.11 -0.35 0 01, 00000,  5.8365, 3.44778,  366.991,  35.1070, 01 Jan 1980, 04:48:40 
36 11 19 40 72  -0.08 -0.35 0 01, 00000,  5.8360, 3.44777,  366.992,  35.1073, 01 Jan 1980, 04:48:50 
37 11 19 50 72  -0.11 -0.36 0 01, 00000,  5.8362, 3.44778,  366.994,  35.1073, 01 Jan 1980, 04:49:00 
 

5 Monitor Mode 
WinADCP has the ability to automatically update the reading of a file as real-
time data collection is occurring.  When the file size increases, (due to real-time 
data collection in another program such as VmDas) Monitor will automatically 
reread the file at selected intervals and display the contents.  When Monitor is 
enabled and the file size is changing, all menu items except Monitor will be un-
available.  You can change the interval by clicking Monitor, Interval.  Enter 
the monitor interval in seconds.   

6 Software History 
Version 1.14 (Jan09 to Present) 

• Added Vista compatibility. 

• Updated icons and copyright information. 

• Renamed 'High Power (CQ)' to 'Power Level (CQ)' and decoded it 
properly in 'File Details' window. 

• Fixed problem with exporting depths in Matlab 
(AnBTDepthcmB1,2,3&4 variable). 

• Renamed ‘GCA’ string to ‘GGA’. 

• Fixed problem with inverting surface track data (mode 15) when pro-
files were referenced to it. 

• Removed Default button from Chart Options  

Version 1.13 (16APR03 – Jan09) 
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• Changed resolution of latitude and longitude data during export from 
0.0001 to 0.00000001 degrees.  

• Fixed problem with exporting Bottom Track depth in Matlab.  

Version 1.12 (14NOV02 - 16APR03): 
• Changed resolution of latitude and longitude data during export from 

0.01 to 0.0001 degrees.  

• Added feature to clip profile data at the bottom or surface (using sur-
face detection).  

• Export Options can now select All bins or None by clicking a button.  

• Changed resolution of depth (pressure) data during export from cm to 
mm.  

Version 1.11 (03DEC01 - 12NOV02): 
• Fixed sign error in along/cross track velocity calculation  

• Fixed error velocity and standard deviation profile scale  

• Fixed sign error in decoding of NB data  

• Added support for Seabird MicroCAT data  

• Added view and export of Lat/Lon data  

• Added Year, Month, and Day export to TXT and MAT files  

• Added additional parameters, including CPU serial number to Utili-
ties/File Details display  

Version 1.10 (29DEC00 - 03DEC01): 
• Added export of BT, WM, and Nav velocities  

Version 1.08 (1MAY00 - 29DEC00): 
• Added capability to reference to navigation data collected through the 

VMDAS and WINRIVER programs  

Version 1.07 (20DEC99 - 1MAY00): 
• Added capability to be called by the VMDAS program for real time 

display  

• Added capability to reference to bottom track data  

Version 1.05 (28APR99 - 20DEC99): 
• First release of the program.  
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NOTES 
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